Technology Assignment-Row Operation on Tl 83

When you document your steps to solving a problem, you’ll need to use mathematical symbols that are
not available on the keyboard of your computer. Some symbols like powers and subscripts and powers
can be formed by formatting regular text. However many mathematical symbols can only be created
using specialized software designed to work with Word and other word processing software.

In this class, you'll need to utilize a software package called Mathtype to create matrices. You can
download the software for free via the link in the Orientation folder. If you are working on a campus
computer, the software has already been downloaded and installed. This software is the standard
software used to create documents containing mathematical symbols.

In this technology assignment, you create a system of equations whose solution corresponds to the
number of letters in your name. Once you have created the system you’ll solve the system with the help
of your calculator and then use Mathtype to document each step.

Your system of equations should have a solution in which the x-value is equal to the number of letters in
your first name and the y-value is equal to the number of letters in your last name. For instance, the

solution (X, y) = (2,1) would correspond to a person whose first name has 2 letters and last name has 1

letter.
There are many systems that could have this solution. For instance, the system
X+y=3
2x-3y =1

has the solution (X, y) = (2,1) . To check, simply substitute X =2 and Yy = linto each equation:

2+ 1=3
2(2)-3(1)=1

Since both equations are true, (X, y) = (2,1) is a solution to the system. You'll need to come up with a
system of equations that corresponds to the number of letters in your name.

Once you have your system, follow the steps below with your system to perform Gauss-Jordan
elimination on your calculator. Then use the information about Mathtype to document the steps you
followed in Word.

Carry Out the Row Operations on a TI-84

The description below describes how to carry out row operations to solve the system of equations
above. You can also do these steps on paper without the use of a calculator.
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1. To solve the system using row operations, we first need to put
the system of equations into an augmented matrix. For the
system above, the augmented matrix is

1 113
| .
2 -311

2.  Turnyour calculator on and press [CLEAR] to erase anything on
the Home Screen.

3. Press to enter the MATRIX menu. This menu allows you
to refer to a matrix’s name, do math with matrices, or edit a
matrix.
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4. We'll start by entering the matrix into the calculator. Use the D]
button to highlight EDIT. The EDIT menu allows you to enter
matrices of any size into matrices with names [A], [B], ect.

5. Press to edit the matrix called [A].

6. The screen shown to the right should look similar to yours. It
indicates that matrix [A] is currently a 2 x 2 matrix (yours may be
different). It also shows the contents of the matrix below the
dimensions.

MATRIx[A] 2 =2

[1 i ]
[E cn ]

7. Since the matrix we are entering is a 2 x 3 matrix, change the

dimensions by pressing 2 3 [ENTER]. Notice that the matrix
below grows to the proper number of rows and columns as you
enter the dimensions. If you have more than 3 columnsin a
matrix, the contents of some of the columns will be off the right
side of the screen and can be accessed using the [{], (4], (<], [+]
buttons.
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8. Enter each of the entries in the augmented matrix followed by
ENTER]. Make sure you have written down this matrix.

MATREIx[A] 2 =3

t: % e

zazx=1

9. Now that we have entered the matrix into the calculator, return
to the home screen by pressing [2nd][MODE].

10. Press to enter the MATRIX menu again.

11. Press [*] to move to the MATH menu in MATRIX.
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12. This menu contains all of the commands we’ll use to do row HAMES r EOIT

operations with your calculator. Use the [+] to scroll down to the AT CumSum
window shown to the right.

DO+
E: #rcur
Ao+

13. The first command we’ll use is *row+( . Scroll down to F: *row+( | |+
using the [+] button and press [ENTER].

14. The syntax for this command is that it requires 4 inputs. Firstis a | | poug+ ¢ =2,
number indicating what we’ll multiply the row by. Second is the
name of the matrix. Third is the row we’ll multiply and last is the
row we’ll add to. In the case of our matrix, we’ll type *row+(-2,
[A],1,2) indicating that we’ll multiply row 1 in the matrix [A] by -
2, and add that to row 2. The result will be placed in the second
row. This should put a 0 in the second row, first column. To start

this command, press [(O)[2][].

15. Next we need to enter the name of the matrix, [A]. Press *ow+ -2 [A] -
to enter the MATRIX menu.

16. Since NAMES is highlighted and 1: [A], we can press to
paste [A] to the *row+( command. If you had stored your
matrix under a different name, you would scroll down to the
appropriate name and press [ENTER].

17. Press[L].

18. The next two inputs indicate the row we’ll multiply and which #pow+l -2, [Al 1.2
row we’ll add to. Press (1] ]2]D].
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19. Press [ENTER] to see the result of the row operation. Notice that ¥pro+s -2, [H12 1.2
the entry in the second row, first column is 0 as desired.

[[1 1 31
B -5 -311
20. We have completed the row operation, but now we need to o+ -2, [Al-1,2
save this new matrix as [A]. Press[ST0®]. This will take the
answer we just found, and store it in some location. [ E%l ];5 -3':5% ]

A=+

21. To specify the location, press [2nd]x-[ENTER]. This will store the *ro+E -2, [H]1 1.2
new matrix in [A]. 2

[[1 1 31
[B -5 -511
Arn=+[A1N

22. Press [ENTER]. Write down this matrix so that you can include itin | |#Fow+¢ 2. [Al 2 1.2
the steps you’ll document using Mathtype. A

[[1 3 1]
[A -5 -5]11]
An=-+[H]
[[1 1 31
[A -5 -311
23. Note that we have a 1 in the first row, first columnand a0 in a
the second row, first column. Now we’ll change the -5 in the [[1 1 31
second row, second column to a 1. To do this we’ll multiply the [B -5 -5]]
second row by -1/5 using the *row( command. The syntax for A=+ [H]
this is *row(-1/5,[A],2). The first input is the number you’ll [ Eé‘ ];5 -':':5} ]
multiply by. The second input is the name of the matrix. The last ot =175, TR .20

input is the row you’ll multiply. The result will be placed in the
row you’ll multiply. Enter the command so that it appears like

the screen on the right. You’ll need to press [2nd][x-1][*] first to
get to the MATRIX MATH menu.
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24. Press to carry out the command. Notice thata 1is now in | |[Hri==* [H]
the proper place in the matrix. [ Eé‘ 15 35% ]
#powl =15, [A]1 222
[[1 1 3]
[ 1 111
25. Store the matrix in [A] by pressing [ST0®](2nd](x-"](ENTER](ENTER]. *¥rowl =15 [A]. 22
Write down this matrix so you can document this step later. [[1 1 3]
[B8 1 111
Hn5+[H][[1 {7
[B8 1 111
|
26. In the last row operation, we need to place a 0 in the first row,
second column. We'll do this by multiplying the second row by - [[1 1 3]
1 and add the result to the first row. Carry out this operation by B 1 111
reproducing the screen to the right (look at steps 12 through A=+ [A]
19) [[1 1 3]
[ 1 111
*¥pow+C 1. [Al 2221
27. Press to carry out the row operation. Notice thata Oisin | |[Hn==+[H]
the proper position. Write down this matrix. It indicates that x is [[1 1 3]
equal to 2 and y is equal to 1. It matches the solution we were ” +0 -1 [E[Il:l} é] i
anticipating so we have completed the Gauss-Jordan process y Fab :' Taed
successfully. [ [ 1 E 2]
[ 1 111

In some instances you may want to interchange two rows of a matrix. You can do this from the MATRIX
MATH menu using the rowSwap( command. Its syntax is

rowSwap( name of matrix, first row to interchange, second row to interchange)

Typing rowSwap([A],1,2) will interchange the first and second rows in matrix [A].

Always remember to store your matrix using the button as you work through the process.
Forgetting to do this is the most common mistake students make.
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Document Your Steps in Word Using Mathtype

Now that we carried out the row operations on a graphing calculator, we'll document those steps using
Word and Mathtype. We want to explain the steps like what we see below:

Step 1: Write down the system of equations.

X+y=3
2x-3y=1

Step 2: Write down the corresponding system of equations.

1 1.3
|
2 31
Step 3: Multiply the first row by -2, add it to the second row and place the result in the second row or

(-2 R1+R2>R2).
1 1,3
|
0 -5,-5

Step 4: Multiply the second row by -1/5 and place the result in the second row (-1/5 R2 > R2).

113
|
0 1)1

Step 5: Multiply the second row by -1, add the result to the first row and place the sum in the first row
(-1R2 + R1 > R1).
1 02
|
0 1)1

Step 6: Read the solution from the augmented matrix, X=2 and y =1.

In the steps below, you’ll learn how to enter a system of equations (as in step 1), an augmented matrix
(as in steps 2 through 5) and an equation on a line (as in step 6).
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Create a System of Equations in Mathtype

1. Start Word 2007.

2. Along the top of Word 2007 you'll see a series of tabs. If Mathtype has been successfully installed,
you’ll see a Mathtype tab. Left click on the Mathtype tab.
- Home Insert Page Layout References Mailings Review View MathType Acroba
% Inline 02 Math - (1) Insert Mumber - + Previous 2% Equation Preferences
E Display ] Other~ &) Insert Reference @ Equations - || E% Format Equations
E Right-numbered - %1 Chapters & Sections = F Mext EL‘“ Convert Equations
Insert Equations Symbals Equation Numbers Browse Format

This panel contains all of the commands to start Mathtype or insert basic symbols. On the right side
is the Insert Equations part of the panel. You can insert an equation within a sentence by left clicking
on Inline. You can insert an equation on a line by itself by left clicking Display. You can even insert
equations labeled with numbers on the right by left clicking on Right-numbered.

The Symbols part of the panel allows you to type Greek letters like o, B or mathematical symbols
like =, oo, or =+.

3. Since we want to create the system of equation on its own line, type some descriptive text (like in
Step 1) and then left click Display.
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A Mathtype window like the one above will appear. This is the window we’ll use to create equations,
matrices and other mathematical creations.

4. Our system of equations is not too complicated and can be created using the buttons on the
keyboard. More complicated expressions we’ll require the use of the buttons you see in the top of
the Mathtype window. Use your keyboard to type in the first equation of your system. The = is
usually in the upper right hand corner of your keyboard.

S MathType - Untitled 1 =10l x| f

File Edit “iew Format 3Style Size  Preferences  Help
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x+y=3

B o

| Style: Math | Size: Ful |Zoom: 200% | Color: i

5. To start your second equation on a new line, press the Enter key on your keyboard.
6. Type the second equation in your system of equations.
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 MathType - Untitled 1 -10O] x|

File Edit WYiew Format Stvle Sigze Preferences Help J

1

z=| iap | wie| ¢

=l 73| gncC || decf | AmB| AD®

Derivs Statistics higtrices

.8
DH| 48| 8 2 | ZuZs] [z
B0 || a|—=|a| == L@ EE 2 |38|0T] 8| 5| &

N ETIE IE

Sets Trig Geamet, Tab & Tab g

3 ey nl 1
«.m lim it = dgg | DR e Af-r] =

e 22

2

Z|x |F |8 |2 |m|—|@|®|a2]| |0l

B (][] [xd (]
|D.|.I.|.l.|.l.|.l1.| |1|I|12.|I|1|.I
xX+y=23
2x—3y=1
w
Kl |
| Style: Math | Size: Ful |Zoom: 200%  |Color v
. . . EE———
7. This system wouIc! look much nicer |f‘the Format Style Size Preferences Help
equa’flons were aligned along the = sign. To i Align Left CErH-ShiFEL
do this, left click on the Format menu along _E i e Chrl4-shift4-] “
the top of the window. Align Right Chrl+Shift+R
8. Select Align at =. Notice that your w
equations line up along the = as desired. Align at . )
I
9. The system of equations is complete. To File Edit Wiew Format Style Size  Preferences
paste this equation into your document, Mew Chrh
left click on the File menu along the top of Gpen... CHO
the window. Close and Return to Docurment2 Ckrl+-F4
10. Select Close and Return to ????. Update Documenk2 h{ ChlS
11. You should now see the system of Save Copy &s...
equations on a separate line in your ]
Prink. .. Ckrl+P
document. I
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Create an Augmented Matrix in Mathtype

1. Start Word 2007.

2. Along the top of Word 2007 you'll see a series of tabs. If Mathtype has been successfully installed,
you’ll see a Mathtype tab. Left click on the Mathtype tab.

3. Type some descriptive text (like in Step 2) and then left click Display.
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4. To start your matrix, create a set of brackets

from the third row of [L]

by selecting
buttons.

5. To create the matrix entries inside of the
brackets, select ==L from the second
row of buttons.

6. Select the lower right hand sub-button to
create a variable sized matrix. Other buttons
create matrices with specific sizes.

7. A box will appear that allows you to enter the number of rows and columns. Enter 2 for rows and 3
for columns as shown below.
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8. You can left click between the rows and columns to create solid lines or dashed lines between the
rows or columns. Put a dashed or solid line between the second and third columns. You may have to
click between the columns more than once to get the type of line you want.

9. Enter the values for your augnmented matrix.

al

10. The augmented matrix is complete. To paste
this equation into your document, left click on
the File menu along the top of the window.

11. Select Close and Return to ????.

12. You should now see the augmented matrix on
a separate line in your document.
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Create an Equation within a Sentence
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1. Start Word 2007.
2. Along the top of Word 2007 you'll see a series — numne maen
of tabs. If Mathtype has been successfully 3 Inline
installed, you'll see a Mathtype tab. Left click on —_ &
the Mathtype tab. %D'Sp'
3. Toinsert an equation within a line like in step 6, _Z! Right-numbered -
type some descriptive text. When you get to the Insert Equations
point where you would like to insert your
equation, left click on Inline.
' i 1
4. Use your keyboard to type the equation, x = 2. R
13. When the equation is complete, paste this File Edit Wiew Format 3Style Size  Preferences He
equation into your document. Left click on the Hew CHI+N
File menu along the top of the window. Open... Chl+0
14. Select Close and Return to ????. Close and Return ta Document2 Chrl4+F4
15. You should now see the equation within the Update Document2 k ChS
sentence in your document. Save Copy As..,
Print. .. Ckrl+P
E:xik Alt+F4 i
1 Ir. gif .
2 20, wideo’che yskuff, gif |
3 CiidgdocsiHarsh Project) Testkest1a, gif |

—_ 1

Using the techniques outlined above, create a Word document and document the steps you used to

solve your system of equations. Use the steps in the box above (steps 1 through 6) as a guide as to how

your document should look.

Once you have documented your steps, save your document and turn it in using the link available

online. Be sure to include your name, class and date in the document.




